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What is Microsoft Outlook? 
 Microsoft Outlook 2003 is a groupware application that supports e-mail, 
scheduling, contacts, “to-do” lists, and other features.  In contrast, Microsoft Outlook 
Express is the free Internet mail and news program that comes with Internet Explorer.  
Microsoft Outlook is a full groupware program that works with Microsoft Exchange 
servers.   

 This handout covers the basic features of Outlook that you are likely to be using 
at UT Austin.  Comprehensive help on Outlook’s features are discussed in on-line 
tutorials at office.microsoft.com Products  Outlook 2003 Help 

   Follow the links. 

 

 

What is the MS Exchange Server? 
  

 Microsoft Exchange is integrated server software that manages electronic mail, 
shared documents, and calendars.  Although Microsoft Outlook does not require a 
Microsoft Exchange server, Outlook offers more functionality when used in conjunction 
with a Microsoft Exchange server. The Exchange server that is owned by Information 
Technology Services is called the Austin Exchange Messaging Service or AEMS. 

 You can activate an ITS Austin Exchange Mail Service account by validating 
your ITS personal computer account for service at http://www.utexas.edu/its/account. 
You can then configure your Exchange mailbox on the Windows Enterprise Support - 
Austin Account Management Page. https://www.austin.utexas.edu/austintools/logon.aspx  

 Your department can set up ITS Exchange Services for you and assign you and e-
mail address and set mailbox limits by going to the ITS TRAC pages 
https://utdirect.utexas.edu/its/account/department/.   There, information specifying 
account numbers as well as the assigned e-mail address will have to be provided.  From 
that time one, billing is automated and does not require advance approval, but rather 
works on the model of *TXShop.  Further information can be obtained from the ITS 
Helpdesk at 475-9400. 

 If your department or college runs an Exchange server that you wish to subscribe 
to, please contact the corresponding Help Desk or Information Technology Support 
Group. 
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Configuring Outlook 

 

Setting Up An Outlook 2003 Profile on Austin Exchange Servers 
 Please go to the ITS Windows Enterprise Services webpage for Outlook 2003 at  
http://www.utexas.edu/its/messaging/outlook03.html and read the document titled 
“Setting Up Outlook 2003 to Access AEMS E-mail and Calendar.”   This is the most 
up-to-date information on setting up Outlook at UT Austin. 

Connecting to the Exchange server from Off-campus 
 

 Normally, you must use UT VPN to connect to the Exchange server from off-
campus using Outlook in order to send and receive e-mail from UT Austin systems. 
Installing and using this product generally will clear up most connection problems with 
UT Austin servers from most Internet Service Providers (ISP).   You can, however, 
configure proxy server information to connect via HTTP rather than TCP/IP to the 
Exchange server, provided that your ISP does not restrict connections via secure HTTP 
connections.  Further information, including information on configuring Proxy server 
information so that Outlook can be used off-campus with Exchange (without having to 
use Cisco’s UT VPN product) can be found at http://www.utexas.edu/its/messaging/get-
started.html.  The processes are similar for Outlook XP and Outlook 2003.  There are 
instructions for each version of Outlook. 

Setting Up UT Austin LDAP Directory Information in Outlook 
 

 To get to all e-mail addresses in the University, you will need to configure 
Outlook to be able to access the UT Austin LDAP directory.   Please go to the web page 
at http://www.utexas.edu/its/messaging and implement the instructions listed in the 
document, Adding the UT Directory to Your Outlook Address Book.  Outlook logins 
must completely time-out before the changes will be implemented to the Address Book 
to allow you to get to directory.utexas.edu addresses.  One way to do this is to reboot 
your system, or implement this change before leaving for the day. 
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The Microsoft Outlook “Interface” 
 

 

Navigation 
Pane  

Folders Reading Pane 

Message List 

Figure:  Microsoft Outlook 2003 interface 

Main Window and Reading Panes 
 The title of the folder you are currently viewing is displayed in its own title bar.  
In the example below, the title of the open folder is Inbox.  The main window is divided 
with folder item headers in the left half and a preview of the selected item displayed in 
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the right half.  You can choose where the reading pane will display by using the View 
menu. Under View choose Reading Pane then Right, Bottom, or Off. 

Navigation Pane 
 The navigation pane appears on the left side of your Outlook window and allows 
you to navigate to any folder or service within Outlook. Folders are expanded by clicking 
the plus sign to the left of the folder name and are collapsed by clicking the minus sign. 
To view the contents of a folder click once on the folder name itself. 

 

 

 

 

 

 

 

The icons at the bottom of the Navigation Pane help you 
navigate to the most commonly used Outlook services. 
You can view them as large icons with text labels, or as 
small graphic icons. To shrink the icons into small 
graphics simply drag the horizontal separation bar 
between the folder list and the icons downward. 

Separation Bar 

Figure: Navigation Pane 

Message List 
 The message list displays information from the e-mail message headers and can be 
sorted in many different ways. To sort by a field other than date, for instance, click the 
Arrange by drop down list and choose how you would like the messages to be sorted. You 
can also specify whether the messages should be sorted in ascending or descending order 
using the drop down menu to the right of the Arrange by menu, as well as display 
messages in groups. 
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Figure:  Sorting Messages 

 To delete a message using the Message List click once on the message to select it 
then click the delete button from the toolbar. You can also delete a message from the 
Message List by selecting the message and pressing the Delete key on your keyboard. 
Once you have deleted a message it will be moved to your Deleted Items folder on your e-
mail server. To permanently delete a message you must also delete it from your Deleted 
Items folder. 

Reading Pane 
 To view a message in the Reading Pane click once on the message in the Message 
List. To open a message in a new window, double-click on the message in the Message 
List. 

 

 

 

 

 

 

 

 

 

 

Sending & Receiving Mail 
 To send a message in Microsoft Outlook, choose New from the File menu and 
select Mail Message or choose Mail Message from the New drop down list in the toolbar. 
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Figure:  Creating a New Mail Message 

 

In the New Message window, type the e-mail address of the recipient, a subject for 
your message, and the text of your message.  You can also format text, i.e., in HTML, but 
note that if the recipient is not using Outlook, your formatting may not display properly.  
When you are ready to send the message, click the Send button on the toolbar. 

 

 
Figure: New Message Window 

Attaching Files 
 To attach a file to a message choose Insert and File or click the paper clip icon in 
the toolbar.  Then select the file you want to attach.  Outlook attaches the document to the 
message. If you receive a message with an attachment, an icon appears near the header 
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information at the top of the email.  Double-click the attachment icon to view the 
attachment. 

 Sometimes attachments created with different programs and different mail systems 
are not easy to read.  If you have difficulty reading an attachment, send a message to the 
sender and request the attachment in a specific format.  A good format for word processing 
files is HTML or RTF.   

Reading Mail 
 To check your messages, click the Inbox icon in the Navigation Pane.  Clicking 
once on the header in the header pane will display the message in the Reading Pane. 
Double-clicking the message header will open the message in a separate window. 

Replying to and Forwarding Messages 
 To reply to a message, select the message in the header pane and click the Reply 
button on the toolbar.  The Reply to All button sends your reply to everyone who received 
the original message.  Use this feature only if you want everyone to see your response.  
Outlook also has a Forward button on the toolbar to forward a message to another e-mail 
address. 

Mail Delivery Options (Signatures and Tracking) 
Microsoft Outlook has several useful Mail Delivery Options that are not available 

with regular Internet mail.  For example, you can attach a signature to all messages by 
default, or you can request to receive notification when your recipient has read the message 
or schedule delivery of the message.  These options require the Microsoft Exchange server.  
Click the Options button on the toolbar top access these features.  This document will 
cover E-mail Signatures and Tracking.   

E-mail Signatures 
 E-mail signatures are easy to configure in Outlook.  From the options menu, select 
Signatures. 

 
Figure: Activating Blind Carbon Copy from New Message Window 

 The E-mail signature dialogue allows you to enter in the actual signature, and 
specify which signature applies to new messages as well as replies to messages. 
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Figure: Signatures in Outlook 2003  

 While you may implement any number of mail signatures, only the signature 
configured in this dialogue to be automatically included with messages will be 
conveniently accessible.   

 Provisions for manually signing messages in Outlook are limited if you use Word 
as your e-mail editor.  If using Outlook as your e-mail editor, signatures will appear on the 
Insert menu when composing messages.  Refer to Outlook Help to get more information 
on using and implementing signatures in Outlook.   

Address Book 
 Outlook has multiple Address books. The Contacts list stores your own list of 
addresses and distribution lists that will be maintained on the server.  The Global Address 
list contains all users and distribution lists on your Exchange server.  The LDAP directory, 
directory.utexas.edu, provides access to all members of the UT Austin community who 
choose to share their e-mail addresses. 

Adding Entries to your Contacts list 
 To add or edit entries in your Contacts list, click on the Contacts icon in the 
Navigation Pane.  

 
Figure:  Contacts Icon 
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In the Contacts window, click the New icon on the toolbar to enter a new contact. 

 

 
Figure:  Contact Entry Window 

Sending Mail Using Contacts List 
 When you want to send mail to a user in your Contacts List, click the To: button 
while composing the mail to display your contacts. If you do not see your contacts listed, 
choose Contacts from the pull down menu. To send to someone from the Global Address 
List generated by the Exchange server, click the To: button and select Global Address 
List from the drop down menu. 
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Figure:  Selecting Global Address List as Source of Email Addresses 

 

 You can add multiple recipients by clicking once on the recipient name in the list, 
then clicking on the To, CC, or BCC buttons. 
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Changing Search Order Of Your Address Book 
 In Outlook, under Tools Address Book Tools Options, you have the ability to 
determine which address list comes first.  Knowing which list comes first is important if 
you communicate with people who belong to other workgroups who might not be 
Exchange subscribers.  There are many duplicate names at UT Austin and it is always good 
to know from which list your e-mail addresses come from. 

 
Figure: Changing Address Book Search Order 

Managing E-mail 
 As you receive more messages, you will want to manage your e-mail more 
efficiently.  Microsoft Outlook has many ways to help you organize your mail. 

Sorting and Finding Messages 
 When you have hundreds of messages in your Inbox, it’s not always easy to locate 
the message you want.  Outlook has Sort and Find features to help. 

 To change how the messages are sorted Right Click the Arranged by bar just 
below the title bar that displays the current folder name in the header pane. 
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Figure: Sorting Messages by Date 

 
 You can also group messages by the selected category or categories, if you check 
the Show in Groups checkbox, your messages will be separated by group labels. 

 
Figure:  Sorting Messages by Group 

 

 If sorting doesn’t help, you can search for text in a message.  Click the Find button 
on the toolbar to display the Find toolbar. Enter the text you want to find in the dialog box 
and select the folders to be searched.  Outlook will search for your text and display a list of 
messages that meet the criteria in the header pane. 

 

 
Figure: Finding Messages Using Find Button 

 

Deleting Messages 
 
 To delete a message, select the message in the header pane and press the Delete key 
on your keyboard or click on the delete tool (the X) on the toolbar.  Outlook transfers the 
message to the Deleted Items folder.  To retrieve a message from Deleted Items, open that 
folder, select the message and choose Edit, Move To Folder and select the folder to move 
it to.  To permanently delete a message, select the message and press Shift + Delete on 
your keyboard. 
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 You can also right-click on messages in the top pane to display a list of commands 
like Print, Delete, Reply, Move To, and others or “drag and drop” the message from its 
current location to the desired destination folder. 

 To permanently remove the contents of the Deleted Items folders on a regular basis, 
do the following: 

 

1. Right Click on Deleted Items and select Properties. 

2. Select the AutoArchive tab and select Archive This Folder Using These Settings.  
Then select Permanently delete old items. 

3. Then, set the interval at which items are deleted by setting the value at Clean out 
items older than... The default is 2 months. 

 

 
Figure:  Using Autoarchive to Automatically Remove Deleted Messages 

Archiving Messages 
 

 The process of archiving messages can be accomplished in two ways, through 
manual archiving or through auto archiving. 

 To archive messages manually, select File Archive. You can select archiving all 
messages under all folders according to the AutoArchive Settings, or archive specific 
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folders.  These messages are normally selected by date.  Further control requires using 
AutoArchive settings. 

  
Figure: Archiving Messages 

 The folder in which messages will be archived is set up in File Data File 
Management. You can change this value to be anything you want it to be.  Files created 
through Outlook archiving tend to be large, so take care that message archives do not 
exceed the size of common backup media, such as Flash drives, CD Roms, Portable Hard 
drives or DVDs   

 To set up automatic Archiving, AutoArchive settings have to be activated for all 
Outlook folders on the Exchange server or specific folders.   Access these settings by left-
clicking on the desired folder, right click Properties, and select the AutoArchive Settings 
Tab: 
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Figure:  AutoArchive Settings Tab 

 

 The AutoArchive tab enables you to remove messages that are older than a specific 
time interval—days, months, etc.—and then to determine how to dispose of them.  A 
system on Active Directory can have automatic retention policies set, or you can set default 
auto-archive settings for all messages. Take care about the size of the archive folder.  
Often, it is better to manually archive messages over a specific time period, such as a fiscal 
year, rather than doing so automatically.   

Further tutorials on archiving messages are available at the Microsoft Office help site at 
office.microsoft.com Outlook  2003 Assistance. 

Folders 
 Use folders to help organize the messages you receive.  For example, you can 
transfer all correspondence with your parents into a folder called Personal.   

1. To create a new folder in your Inbox, choose File New and then select New 
Folder. 
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2. Type a name for the folder in the dialog box, and select the type of information the 
folder will contain.  Finally, select the destination for the folder in the dialog box 
and click OK. (To create the folder in your Inbox, click on the Inbox.) 

 

 
Figure: Creating a New Folder For Saving Messages 

3. To move a message to another folder, select the message and choose Edit and 
Move to Folder or Copy to Folder if you want to copy the message to another 
folder. To simply move the message, you can also drag it from the header pane to 
the appropriate folder in the Navigation pane. 

4. You can also set up a Message Rule to automatically move messages to your new 
mail folder. 

Message “Rules” and Filters 
 

In Outlook you can create “rules” that filter your mail.  For example, you might 
want to automatically transfer all messages from your friend in College Station, Joe 
Billionaire, to a folder called Personal, or automatically delete messages that have the 
phrase “get rich quick” anywhere in the message. 

 

1. To create a mail filter, choose Tools and then select Rules and Alerts. 
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2. Click the New Rule button. 

3. Select the type of rule you want to create.  Then click the underlined words in the 
Rules Description section of the dialog box and fill in the required information. For 
example, the rule in the example below moves all messages from Joe User to the 
folder called Finances. (finan in the illustration) 

 

 
Figure: Message Rules for Automatically Handling Messages 
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4. To run the rule anytime you want, including when the rule’s behavior or criteria are 
modified, select the rule you want to run and select Run Rules Now.  You can run 
rules on all folders, or you can select a specific folder run the rules again. 

 

 
Figure:  Typical Email Rule Names and Details of Sample Rule 
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Calendars and Scheduling 
 

 Microsoft Outlook is a sophisticated personal and group scheduling program.  Click 
the Calendar button in the Navigation Pane to use the scheduling feature of Outlook.  
Outlook's Calendar appears in the figure below. 

 

 
Figure: Outlook Calendar on Exchange 

To schedule a new appointment: 
1. Choose File New and select Appointment or click the New button in the toolbar 

and choose Appointment.   

2. Enter information about the time, date, and location of the appointment.   

3. If your meeting is recurring, click the Recurrence button to specify the details of 
how often and when the meetings Recurs. 
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Figure:  Meeting Recurrence 

4. Click Save and Close to schedule the meeting.  It will now appear on your Outlook 
calendar. 
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Scheduling Meetings and Rooms 
 Outlook can also be used to schedule meetings with other users on your Exchange 
Server.   

To schedule a meeting with multiple people: 

 

 
Figure: Example of A Meeting With Multiple Attendees 

 

1. Select File New and choose Meeting Request or select Meeting Request from the 
New button drop down list. 

2. Click the To: button to select the people you need to attend the meeting.  

3. Specify a Subject, Location, Date and Time.  If your meeting attendees also use 
your Exchange server, you can check their availability by clicking the Scheduling 
tab.  It will display the free and busy times of the other meeting attendees.  You can 
even have Outlook select the first date and time that all parties are available by 
choosing AutoPick.  If you select a Resource, its schedule can also be taken into 
consideration when setting up a meeting with a group of people.   

4. To automatically be added to the schedule for the resource, i.e., a room, you have to 
have the ability to Create items for that resource, which the owner can grant as a 
permission or delegate.  Otherwise, the resource owner as well as all participants 
must accept the proposed meeting. 
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5. The meeting appointment is sent like an e-mail message.  Attendees will be 
prompted to accept or decline and send automatic notification back to you. When 
they accept, the meeting will automatically be added to their own Outlook calendar.  
After creating the meeting, to mark it as Private, right click on the meeting and 
select Private off of the drop-down menu. 
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Figure:  Sample Calendar Entry For A Single Day 

Assigning Permissions/Delegates 
 

 You may want to allow other Exchange users to have access to some of your 
services in AEMS. Assigning delegates grants other users permission to do things like view 
your calendar, send e-mail messages on your behalf, and tasks to your to-do list, and more. 

 

To add a delegate: 

1. From the Tools menu choose Options, then click the Delegates tab. 

2. Click the Add button and select the delegate from the Global Address List. 

3. Click the Add button in the dialog box to add that person as a delegate. 

4. Assign the appropriate permissions for each service and click OK. 
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Figure:  Sharing A Calendar 

 

To share your calendar folder: 

1. Click on the Calendar icon to switch to the Calendar view. 

2. Right click on your calendar from the Navigation Pane 

3. Click on the Permissions tab 

4. Click on the Add button to locate the user from the Global Address list you want to 
add. 

5. Click on the specific individual to update their permissions.  You can also set 
default permissions for all users of the Exchange server. 
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Figure:  Calendar Permissions 

To view someone else’s calendar/folder: 
 If another Exchange user has made you a delegate, or has shared one of his 
Exchange folders, such as his calendar, you can view it and may be allowed certain editing 
privileges. 

1. From the File menu select Open > Other User’s Folder. 

 
Figure: Looking At Someone Else’s Calendar 

2. Click the Name button to locate the user from the Global Address List and click 
OK. 
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3. Select which folder you would like to view from the Folder type: field and click 
OK. 

 

“To-Do” Tasks 
 You can create new tasks in Outlook while by choosing Task from the New button 
in the toolbar or by entering the task directly into the Task window.  To view the Task 
window, click the Tasks button in the Navigation pane.  

 

 
Figure:  To Do/Task List In Outlook 

 

 To enter a new task from the New > Task button, enter the information for the 
subject, dates, status, and details. To assign the task to someone on the Exchange server, 
click the Assign Task button in the toolbar then click the To: button to find the recipient. 
The recipient will receive the task in his/her Inbox with all of the information you entered 
included. 
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Figure: Entering In A Task 

 To enter a task from the Task window, simply click in the next empty row and 
begin typing. When you press Enter, the task is added to your To-Do list.  Tasks are kept in 
the Tasks folder and are also displayed in your Outlook Today view for the week ahead.   

 Tasks can also be made recurring, which will then enable Outlook to pop up a 
reminder on a regular basis, such as when a weekly report is due.  A recurring task can be 
assigned to other people too.  In the Task window, click on Recurrence, and fill in the 
appropriate checkbox, including the End Date of the Task Recurrence.  
 

 
Figure:  Task Recurrence 
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Other Cool Features 

Notes & Journal Entries 
 

 Like appointments and tasks, you can create “sticky” notes and/or journal entries 
which can be saved for yourself and/or sent to others on the Exchange Server.   

Public Folders 
 

 Public folders which can be viewed and shared by others on the Exchange Server 
can be created by the server administrator.  To view a Public Folder click the folder list 
icon in the Navigation pane. Near the bottom of the list you will see Public Folders with a 
plus sign next to it. Click the plus sign to expand the necessary folders until you find the 
folder you are looking for. 

 

Conclusion 
 

 Outlook is a flexible and dependable communications program that utilizes the 
services provided by Microsoft Exchange services to facility individual and group 
productivity. 
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